Sysgem SysMan Remote Control

User Guide

By Sysgem AG

Sysgem ® is a registered trademark of Sysgem AG. Other brands and products are registered trademarks of their
respective holders. © 2012 Sysgem AG, Lavaterstrasse 45, CH-8002 Zürich, Switzerland, office@sysgem.com. All
rights reserved.

Contents
Introduction

1

Purpose of this Guide ...........................................................................................................1
Contact Us ...........................................................................................................................1

Definitions

3

Basic Terminology...............................................................................................................3
General ..................................................................................................................3
SysMan Utilities ....................................................................................................3
SysMan UT............................................................................................................3
SysMan RC............................................................................................................3
SysMan Remote Control Client .............................................................................3
SysMan Remote Control Server ............................................................................4
SysMan Remote Control Client User Interface .....................................................4
SysMan Remote Control Server service ................................................................4

Getting Started

5

Start Remote Control ...........................................................................................................5
Startup Icon ...........................................................................................................5
Explore the Network..............................................................................................5
Connect to a Remote System for the First Time ..................................................................7
Install the Remote Control Server Automatically ..................................................7
Initiate connection ............................................................................................... 11
Ending a Session ................................................................................................................ 12
Disconnect from the Remote Server .................................................................... 12

RC Client User Interface

13

Managing Remote Sessions - The File Menu .................................................................... 13
New Window ....................................................................................................... 13
Managing connections ......................................................................................... 13
User Interface Preferences ................................................................................... 14
Exit the application .............................................................................................. 14
Managing the User Interface - View Options .................................................................... 15
Show / Hide Toolbar and Status Bar ................................................................... 15
Multiple Monitors................................................................................................ 15
Screen Scaling Options ........................................................................................ 15
Desktop Control .................................................................................................. 16
Remote and Local Cursor Options ...................................................................... 16
Forwarding Hotkeys - The Send Menu .............................................................................. 17
Pre-defined Hotkey Combinations ...................................................................... 17
Remote Connection Tools ................................................................................................. 18
Starting a Chat Session with the Remote User .................................................... 18
Transferring Files Between Server and Client ..................................................... 19
Manage Server Installations and Settings ............................................................ 19

Access Credentials

21

Credentials for Logging On to a Target Machine .............................................................. 21
General ................................................................................................................ 21
Manually Enter Access Credentials ..................................................................... 22

Sysgem SysMan Remote Control User Guide

Contents  Error! Reference source not found.

Default Credentials and Definitions ....................................................................23

Managing RC Server Installations and Settings

25

The SysMan Remote Control Service Status Dialog .........................................................25
A Central Point for Managing the RC Services ...................................................25
Verify RC Server Status ......................................................................................27
RC Server Service Installation ...........................................................................................28
Automatic Remote Installation upon Connection ................................................28
Remote Installation from the SysMan RC Window ............................................28
Manual Local Installation ....................................................................................31
RC Server Service Un-installation .....................................................................................35
Remote Uninstall from the SysMan RC Window................................................35
Manual Local Uninstallation ...............................................................................36
Managing SysMan RC Server Service Settings .................................................................37
Manage Settings Remotely from the RC Client ..................................................37
Manage Local Settings on the RC Server ............................................................41

Multiple Simultaneous Sessions

43

Simultaneous Multiple Remote Sessions ...........................................................................43
Multiple Remote Control Sessions from a Single SysMan Client .......................43
Multiple RC Sessions to a Single Server from Multiple SysMan Clients ...........45

RC Server User Interface

47

Local Management ............................................................................................................47
Notification Icon ..................................................................................................47
RC Server Notification Icon Menu Options ........................................................48
Connection Control ............................................................................................................49
Accept / Reject a Session .....................................................................................49
Confirmation That a Session has Begun ..............................................................50
Terminating Sessions ...........................................................................................51
Interaction with the Connected Client................................................................................52
Chat in Current Session .......................................................................................52

ii  Contents

Sysgem SysMan Remote Control User Guide

Introduction
Purpose of this Guide
Sysgem SysMan Utilities helps you, as an IT professional, to take control of
machines in the Windows Domain in a convenient, reliable and secure manner.
Tools are available at your fingertips, not only to view a spectrum of system
management status attributes, but also to remotely connect to systems using
SysMan Remote Control.
This is the guide to using Sysgem’s SysMan Remote Control. The product is
installed on your Windows workstation as part of the Sysgem SysMan Utilities
program and thereafter connects to remote machines on your network. Access to
the remote machines uses your Windows user account credentials, or if your
account has insufficient access, it can either use a special SysMan Remote
Control Server password or the credentials of another account that does have the
appropriate level of access.

Contact Us
If you need information or assistance with SysMan then as a first point of contact
please get in touch with your supplier.
If you need to contact Sysgem Distribution for:
o
o
o

Sales support
Information on software updates and release notes
Frequently Asked Questions

... please visit: http://www.sysgem.eu/, or send email to sales@sysgem.eu.
If you need assistance from 'Sysgem Distribution' for:
o

Technical Support

… then please visit: http://support.sysgem.eu/.
For other information visit our Knowledge Base:
… please visit: http://kb.sysgem.eu/.
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Definitions
Basic Terminology
General
This section contains a brief description of the components of the software and
the terms used in:
o
o
o

this guide
the product itself
the online knowledgebase

SysMan Utilities
Containing the main SysMan user interface, SysMan Utilities is the starting
point for all SysMan actions, including the initiation of a Remote Control
session.
From a licensing point of view:
o
o

A SysMan Utilities license automatically includes licensing for SysMan
Remote Control;
alternatively, a SysMan Remote Control license includes a light-weight
version of SysMan Utilities to supply some basic Remote Control
related operations (e.g. assigning connection preferences, maintaining
manual connection definitions and favorites, Active Directory browsing
and starting SysMan RC from the context of a node).

Please refer to the SysMan Utilities user guide for any related information.

SysMan UT
Abbreviation for SysMan Utilities

SysMan RC
Abbreviation for SysMan Remote Control

SysMan Remote Control Client
We refer to the machine that you are using (such as your workstation) to
establish connections to remote machines as the “SysMan Remote Control
Client” – i.e. the “client” refers to the machine you connect “from”.
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SysMan Remote Control Server
With the term “SysMan Remote Control Server” we refer to the machine being
remotely controlled – i.e. the “server” refers to the machine you connect “to”.

SysMan Remote Control Client User Interface
The SysMan Remote Control client user interface is the window in which the remote
session is displayed. It is invoked from the SysMan Utilities window.

SysMan Remote Control Server service
The service that runs the SysMan Remote Control server is installed on remote
machines to which connections are to be made using the SysMan Remote Control
Client. This service can be installed:
o
o
o

remotely from the client, or
manually after logging into the remote machine, or
via any software distribution service you may be using

After installation, the service runs as a Windows service called SysMan Remote
Control Server.
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Getting Started
Start Remote Control
Startup Icon
SysMan Remote Control is started from within the SysMan Utilities program.
Double click on the Sysgem SysMan Utilities icon that has been placed on your
Windows desktop during the installation of the product.

Explore the Network
The SysMan desktop opens up and automatically starts the “SysMan Explorer”
window.
If the SysMan Explorer window has been closed, it can be opened again from the
bookmark options on the left-hand side of the screen:
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Open up the explorer tree in the left-hand side of the “SysMan Explorer”
window and select the machine that you want to use with Remote Control.

In this example, the SYSGEM-WS2 machine has been selected in the
explorer tree on the left. All the SysMan Utilities tools that are available on
SYSGEM-WS2 are shown in the pane on the right, including the SysMan
Remote Control option (which is selected in the example above).
Double click on the SysMan Remote Control option to open a new window
and connect to the selected machine.
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Connect to a Remote System for the First Time
Install the Remote Control Server Automatically
Before SysMan Remote Control can connect to a remote machine, the Remote
Control service must first be installed on that machine.
If an attempt is made to connect to a remote machine which does not have the
Remote Control Server service installed, then SysMan will prompt you to start
the service status dialog as shown below. Click “Yes”:
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The SysMan Remote Control Service Status dialog is started and automatically
verifies the RC Server service installation status on the remote machine. If the
service is not installed, SysMan will offer to start the remote installation. Again,
click “Yes”.
Note: The service installation process needs sufficient privileges on the remote
machine for the installation to succeed. If your Windows user account is a
member of the Administrators group, the installation should proceed without the
need to provide any further credentials. If it does not, then cancel the “Install it
now?” prompt and provide sufficient credentials first, typically of an account
that is a member of the Administrators group.
For more information, please refer to the “Credentials for Logging on to the
Remote Machine” section later in this guide.
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Before the remote installation begins, the Installation Options dialog is
displayed to allow server options to be provided.
Note: the settings configured here can be changed after installation, as shown
later in this guide.

Session password:
o Password: The optional session password entered in this field permits
a connection to the remote machine to be made without using
Windows credentials.
o Confirm: Re-type the chosen session password here for confirmation.
Server options:
o Show connection list when active: If this option is set, a window will
be displayed on the target system indicating that Remote Control
session(s) are active, and which IP address(es) are connected.
o Allow user to control incoming connections: If set, a user that is
logged on to the remote machine has the option to reject a connection.
Note: if this option is set, then by default the server is configured to
automatically reject connection requests after a 10-second timeout.
o Allow user to change Remote Control settings: If enabled, then the
user of the target system can open the server’s Options dialog box to
change the server configuration.
After selecting appropriate installation options above, press the “Install”
button to start remote installation.
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The remote installation progress is displayed, as shown below. Wait for the
installation to complete and click “Close” to close the Installation Progress
window.

After successful installation, the SysMan RC client will offer to connect to the
newly-installed server, as shown below:
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Initiate connection
After accepting the offer to connect to the server in the previous step, the
Connect To dialog box will be displayed with the server name already set
appropriately.
If you configured a session password when installing the server, enter it in the
Password field and click “OK” to connect. If you did not specify a session
password, you will need to use Windows credentials to authenticate; to do this,
change the Type field to “SysMan Remote Control (with Windows username
and password)” and then provide a suitable username and password in the
appropriate fields.

After clicking OK, the RC client will attempt to connect to the remote server.
Upon successful connection, the remote display is presented in the Remote
Control window.
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Ending a Session
Disconnect from the Remote Server
From the SysMan client, a session can be ended by:
o selecting the File > Disconnect menu option, or
o clicking the Disconnect icon on the main toolbar:

, or

o closing the SysMan Remote Control Window

Note: The logged in user on the target machine can also be granted the privilege
to disconnect Remote Control sessions from his desktop (see the Remote
Sessions section, below, for details).
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RC Client User Interface
Managing Remote Sessions - The File Menu
All actions related to the starting and stopping of a session can be invoked from the
File menu:

New Window
File Menu:
o New Window: Opens a new instance of the SysMan Remote Control client
user interface, in which a new connection can be started.

Managing connections
File Menu:
o Connect To…: This option starts the Connect To dialog, allowing a
connection to be started manually (rather than initiating a connection from
the SysMan Utilities browser window).

For more information on this dialog please refer to the Manually Enter
Access Credentials section of this document.

o

Disconnect: Disconnects the currently-active session.
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User Interface Preferences
File Menu:
o Preferences: opens a dialog box where preferences can be configured for
the RC Client user interface.

Display preferences:
o Shrink remote display to fit window: This option shrinks the remote
display to fit the SysMan Remote Control window. It does not alter the
remote display’s resolution.
o Resize window to fit display: By enabling this option, SysMan Remote
Control will automatically attempt to adapt its window size to the size of
the remote display upon connection.

Multiple monitors:
These options control how SysMan displays the remote desktop after connection,
when the remote machine has more than one monitor in use.
o Show entire desktop by default: This option shows all the remote displays
in a single SysMan Remote Control window.
o Show primary monitor by default: Initially show the primary monitor only.

When a connection fails:
o Offer to check the service status: When this option is enabled, failed
connection attempts will be followed by a prompt to open the SysMan RC
Service Status dialog in order to check whether the SysMan Remote
Control Server service is installed and running on the target machine.

Exit the application
File Menu:
o Exit: Ends the current session (if any) and closes the RC client user
interface.
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Managing the User Interface - View Options
The SysMan Remote Control window View menu holds various commands to alter
the current display mode and settings.

Show / Hide Toolbar and Status Bar
View Menu:
o Toolbar: Shows or hides the toolbar
o Status bar: Shows or hides the status bar

Multiple Monitors
View Menu:
o Monitors > Entire Desktop: Show all of the remote displays in a single
SysMan Remote Control window
o Monitors > Monitor selection: Only show the selected monitor

Screen Scaling Options
View Menu
o Full Screen: Currently not available
o Shrink to Fit Window: Shrink the remote display to fit the SysMan Remote
Control window. The resolution setting on the target machine will not be
affected.
o Resize Window to Fit: Attempt to adapt the size of the SysMan Remote
Control user interface window to the size of the remote display.
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Desktop Control
View Menu:
o View Only: Don’t allow control of the remote machine from the SysMan
Remote Control user interface.
o Lock Remote Keyboard and Mouse: Prohibits desktop control on the server
side. That is, temporary prevents the user sitting behind the remote screen
from controlling the keyboard and mouse.

Remote and Local Cursor Options
View Menu:
o Local Cursor as Dot: Show the local cursor as a dot, thereby
distinguishing it from the cursor on the remote machine
o Remote Cursor: Shows or hides the cursor from the remote machine
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Forwarding Hotkeys - The Send Menu
The SysMan Remote Control client user interface has several predefined hotkeys
that can be sent to the target system in a session. All of these are available from
the Send menu.

Pre-defined Hotkey Combinations
Send Menu:
o

Ctrl-Esc: Forwards Ctrl-Escape (primarily to activate the Start menu).

o

Alt-Tab: Forwards the Alt-Tab hotkey, to switch between windows on
the remote desktop

o

Alt-Esc: Forwards Alt-Escape to place the active window on the
remote desktop behind all others (if any)

o

Ctrl-Alt-Del: Opens the security or logon screen

o

Ctrl-Shift-Esc: Equivalent to pressing Ctrl-Shift-Escape on the remote
machine, typically opening the Windows task manager

o

Capture Hotkeys: Currently not available

Note: the function of these special key combinations may differ from the above
when connecting to non-Windows systems using SysMan RC’s VNC support.
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Remote Connection Tools
As well controlling the remote desktop, SysMan offers the means to exchange
information with the remote node. These are accessible through the Tools menu:

Starting a Chat Session with the Remote User
Tools Menu:
o Chat with Remote: Start a chat session with the user sitting behind the
remote desktop. Selecting this menu item will open a chat window, as the
example below shows. It allows interaction between the users on each side
of the connection:
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Transferring Files Between Server and Client
Tools Menu:
o

Transfer Files: This menu will display a file browser window that
permits files to be selected and transferred in either direction.

To transfer a file (or multiple files) from the client machine to the
target server, select the source file and browse for the target location,
then click the “Send >>” button.
Likewise, to start a transfer from the remote server to the client
machine, select the file on the server side, browse to the required
location on the client side and then click the “<< Receive” button.

Manage Server Installations and Settings
Tools Menu:
o

SysMan Remote Control Service Status and Installation…:
Opens the SysMan Remote Control Service Status dialog box, allowing
remote service installations, un-installations and reconfiguration.
For more information on this option, please refer to the “Managing RC
Server Settings and Installations - The SysMan Remote Control Service
Status” dialog section of this document.
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Access Credentials
Credentials for Logging On to a Target Machine
General
You need sufficient access credentials in order to gain access to a remote system
with SysMan Remote Control.
The options are:
1.

Use the username and password belonging to a suitably-privileged
Windows user account.

2.

Use the SysMan Remote Control Server session password if one was
set when the service was installed.

When do you enter the details?
1.

The credentials can be entered in the Remote Control client’s Connect
To dialog box, either when starting a connection directly from the
Remote Control window or when no credentials are saved in SysMan
Utilities (see below)

2.

The details can be set up (and stored) for each remote machine so that
they are used automatically whenever you select a machine in the
“SysMan Explorer” window and invoke the “SysMan Remote Control”
tool.
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Manually Enter Access Credentials
In the Remote Control window, either:
o

Use the menu option: File > Connect To…

o

Click the Connect icon on the main toolbar:

... and select the computer you wish to connect to.

The Type field in the dialog box allows either a Windows user account to be
used for access, or the session password that was configured when the service
was installed.
If you select the “SysMan Remote Control (with Windows username and
password)” option, then enter the details of a suitably-privileged account (by
default, a member of the machine’s Administrators group).
If you select the “SysMan Remote Control (with connection password)” option,
then the username field will be grayed out and you should enter the session
password in the password field.
Note: There is also a VNC option available in the connection type list, which
allows the SysMan RC user interface to establish a connection with an existing
VNC server on the remote machine (e.g. Linux, UNIX, Mac, and other platforms
with VNC support). Please refer to our knowledgebase (http://kb.sysgem.eu,
article RC KB #0004) for further details.
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Default Credentials and Definitions
For convenience, you may set up access details that will be automatically used
whenever the Remote Control tool is started from the “SysMan Explorer” window.
Default credentials can be set for a specific machine, a number of selected machines
at once, or as general default definitions (which will be applied when there are no
specific credentials set for a certain node).
To define general default definitions, right-click anywhere in the “SysMan Explorer”
window and select: “Preference Settings”, then select: “Connection Preferences”.
Use the menu option: “General” > “Default Credentials”.
To set up machine specific credentials, select all machines you wish to share the
same set of credentials in the “Connection Preferences” window, then use the right
mouse menu option: “Selected” > “Credentials”.
Select the Remote Control tab:

In both the General Defaults settings and the Selected Nodes settings, the following
options for credentials may be specified:
o

The same as for Tools and Utilities:
Use the same credentials as defined on the Tools and Utilities tab.

o

Always prompt for credentials:
Which forces the Connect To window to always ask for credentials

o

Specific user (Windows) credentials:
Use the credentials of a specified user. By default, members of the
Administrators group on the remote machine are granted access.
For domain-accounts, enter the windows username as
<DOMAIN>\<Account name>, e.g. SYSGEM\Administrator
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o

SysMan RC Password:
Use the SysMan Remote Control Server password

When configuring credentials in the Selected Nodes dialog box, the specified details
will only be used if the Enabled checkbox is set – when not enabled, the general
default credentials will be used instead.
At any time, if the login fails for a remote control session, then an “Authentication
Failed” message will be displayed and the “Connect To” dialog will be opened to
allow you to enter credentials manually.
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Managing RC Server
Installations and Settings
The SysMan Remote Control Service Status Dialog
A Central Point for Managing the RC Services
All tools related to remote management of the SysMan Remote Control Server
service can be accessed from a single starting point: the SysMan Remote Control
Service Status dialog. This dialog can be opened from the Tools menu:
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If a session is active when the SysMan RC Service Status dialog is opened, it will
default to the current remote server. To work with a different computer, or if no
session is active, type the name of the target computer (or use the Browse… button to
find it on the network):

General notes on the SysMan RC Service Status dialog:
o

Computer: Holds the name or address of the target machine. By default, this
will be the last server used in the current RC window.
If the name or address of the target is known then it can be typed here.
Alternatively use the Browse… button to locate the target machine

o

Use current Windows credentials: All actions available in this window
require administrative privileges on the remote machine to succeed. By
default, the SysMan RC Service Status dialog uses the current Windows
logon credentials to authenticate with the target node. If the current
Windows privileges are expected to be insufficient then uncheck the “Use
current Windows credentials” option, to extend the dialog with a username
and password field where alternative logon information can be provided:
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Verify RC Server Status
To check remote service existence and status from the RC client window, start the
SysMan Remote Control Service Status dialog (as described in the preceding
section).
Ensure the correct computer name and appropriate Windows credentials are selected,
and click the Status button to continue:

If the RC Server service doesn’t appear to be installed, SysMan automatically offers
to initiate a remote installation of the service right away.
If the RC Server service is installed and accessible on the target then its status and
version will be shown in the appropriate fields in the SysMan RC Server Status
dialog.
From this point the following maintenance actions could be performed:
o

Inspect the remote server settings, and if desired make changes, by clicking
the Settings… button

o

Initiate a remote upgrade or reinstallation: click the Install… button
Note: The client will install its embedded version of the RC server.

o

Initiate a remote uninstall of the server service: click the Uninstall button

o

Start a connection to this target by clicking Connect…, which will open the
Connect To… dialog box with the server pre-selected

o

Perform service control, by starting, stopping or restarting the RC server
service using the appropriate buttons

Managing the RC Server settings and performing remote installations from this
window is described in detail in the sections below.
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RC Server Service Installation
Automatic Remote Installation upon Connection
If, upon a connection attempt, the RC service does not appear to be installed on the
target server, SysMan RC can initiate an automatic installation. This feature is
described in more details in the “Getting Started - Connect to a Remote System for
the First Time” section earlier in this guide.

Remote Installation from the SysMan RC Window
To manually start a remote installation of the RC Server from the RC client window,
open the SysMan Remote Control Service Status dialog and select the correct
computer and Windows credentials (as described in the section above). Then, click
the Install… button to continue:
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Pressing the Install… button in the SysMan RC Service Status dialog will open the
Installation Options dialog box:

Specify the required installation options and press Install to start remote installation
of the service.
Note: The settings specified here can be changed after installation, as shown later in
this guide.
Session password:
o Password: The optional session password entered in this field permits
a connection to the remote machine to be made without using
Windows credentials.
o Confirm: Re-type the chosen session password here for confirmation.
Server options:
o Show connection list when active: If this option is set, a window will
be displayed on the target system indicating that Remote Control
session(s) are active, and which IP address(es) are connected.
o Allow user to control incoming connections: If set, a user that is
logged on to the remote machine has the option to reject a connection.
Note: if this option is set, then by default the server is configured to
automatically reject connection requests after a 10-second timeout.
o Allow user to change Remote Control settings: If enabled, then the
user of the target system can open the server’s Options dialog box to
change the server configuration.
After selecting appropriate installation options above, press the “Install” button to
start remote installation.
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The remote installation progress is displayed, as shown below. Wait for the
installation to complete and click “Close” to close the Installation Progress window.

After successful installation, the SysMan RC client will offer to connect to the
newly-installed server, as shown below:

o

To connect to the newly-installed server, click Yes.

o

To return to the SysMan RC Service Status dialog, for instance to check
and set more detailed settings on the newly-installed server, click No.
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Manual Local Installation
Apart from automatic or manual remote installation from the SysMan RC client,
the SysMan Remote Control Server service can also be installed manually on the
local machine.
The RC Server installation package comes as an MSI file which can either be
installed by hand or used with any software distribution systems you may have
in place on your network.
On the RC client system, browse to the Sysgem\SysMan Remote Control
installation folder and copy the SysManRCServer.msi package to a more
convenient location – this could be the local desktop, an accessible share, or
some other shared folder the target server has access to.
Log on locally on the target server and run SysManRCServer.msi, which will
start the SysMan Remote Control Server Setup Wizard:
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Click Next, read and accept the license agreement to continue, approve or alter
the destination folder and set the RC session password (if desired):
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On the next page, set the server options as required.
Note: the settings applied here can be changed after installation.
o

Show connection list when active: If this option is set, then a window is
displayed on the target system indicating that Remote Control
session(s) are active, and which IP address(es) are connected.

o

Allow user to control incoming connections: If set, a user that is logged
on to the remote machine has the option to reject a connection.
Note: if this option is set, then by default the server is configured to
automatically reject connection requests after a 10-second timeout.

o

Allow user to change Remote Control settings: If enabled, then the user
of the target system can open the server’s Options dialog box to change
the server configuration.
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On the final page of the installer, click Install to being the installation, wait for
the “Completed the SysMan Remote Control Server Setup Wizard” window to
confirm successful installation, and close the wizard.
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RC Server Service Un-installation
Remote Uninstall from the SysMan RC Window
To manually start a remote uninstallation of the RC Server from the RC client
window, open the SysMan Remote Control Service Status dialog and select the
correct computer and Windows credentials (as described in the section above).
Then, click the Uninstall button to continue.

The uninstallation progress is displayed in the form below. Wait for the
uninstallation to finish and click Close to close the Uninstallation Progress
window.
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Manual Local Uninstallation
The SysMan Remote Control Server service can be removed, if necessary, from
the target machine by using the standard Windows Administrative tools to
uninstall a program (typically found in the Control Panel). In the list of installed
programs, the SysMan RC Server service will be listed as SysMan Remote
Control Server:
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Managing SysMan RC Server Service Settings
Manage Settings Remotely from the RC Client
Verify the existence and version of the RC Server service on the target, as
described in the Verify RC Server Status section above. Next, in the SysMan RC
Service Status dialog box, click Settings… to load the remote server settings.

The server settings on the remote machine are displayed on the next page.
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General Options:
o

Force view-only mode: With this option, the user of SysMan Remote
Control can only observe the desktop of the target machine. They will
not have the ability to control the keyboard and mouse.

o

Lock server settings: The user of the target machine will not be able to
change the SysMan Remote Control Server configuration.

o

Allow remote sessions to be closed: If checked, the user on the target
machine will have the ability to disconnect any established sessions.

o

Allow Remote Control to be shut down: Permit the Remote Control
Server service to be shut down from the desktop of the target machine
by the user who is logged on locally on the target machine.

o

Show connection list when active: A window will be displayed on the
target machine whenever a Remote Control session is active. The
window shows the IP address(es) of the user(s) who are connected.

o

Share only primary monitor: If set on a multi-monitor machine, then
only the primary monitor will be available for display by SysMan.

Connection Control:
o

Confirm incoming connections: The user who is logged on to the target
machine will be prompted before the Remote Control window is
allowed to connect to the target machine. The user can accept or reject
the connection request.

o

Default action: If no response is made to the prompt requesting
permission to connect, then the default action (after the timeout period
has elapsed) will be to accept or reject the connection, depending on
this setting.

o

Timeout: This defines the number of seconds before the session request
is automatically accepted or rejected.
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Session Passwords:
o

Allow logon with session password: This allows someone who has
knowledge of the Remote Control session password to connect to the
target machine without providing a Windows username and password.

o

Password: The Remote Control Server session password.

o

View-Only Password: If this alternate password is used to establish the
connection, the Remote Control session will be in read-only mode.

Windows Authentication
o

Allow logon with Windows Credentials: This allows a SysMan Remote
Control user to connect to the target machine using a privileged user’s
Windows credentials.

o

Configure Allowed Groups: Assign connection privileges to Windows
groups, or specific users. By default members of the local
Administrators group have been assigned full access.
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In order to apply any changes to the server settings, the service needs to be
restarted. When changes have been made, SysMan will prompt to restart the
service automatically:

Note: any current connections to this target will be terminated when the service
is restarted. Any affected SysMan RC users will be prompted to re-establish the
connection:
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Manage Local Settings on the RC Server
To open the RC Server settings locally, right-click the RC Server icon in the
Windows notification area.
Either:
Server in listening mode: no connections are active

Server active: one or more remote clients are connected.

From the menu that appears, click Settings… to open the server settings for the
local machine:

For a detailed discussion on these settings, please refer to the preceding section
on remote management.
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Multiple Simultaneous Sessions
Simultaneous Multiple Remote Sessions
Multiple Remote Control Sessions from a Single
SysMan Client
A single client station can open multiple SysMan RC sessions at the same time by
using the following procedure:
o

On the left side of the SysMan Explorer window select the ‘container’
folder that contains the required machines. In the example below the
“Windows Network” container has been selected in the left pane of the
SysMan Explorer. On the right side of the SysMan Explorer the three
machines: “SYSGEM-DC01”; “SYSGEM-WS02” and “SYSGEM-WS3”
have been selected.

o

Using the right mouse key on the selected machines, the menu option:
“Multiple Computer Select” is chosen and this opens the window shown in
the following screenshot:
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o
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Any of the tools selected on this window will start a display by connecting
to the selected machines and will display the results in that window. In the
case of the Remote Control option it will open three separate windows
each connected to one of the machines.
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Multiple RC Sessions to a Single Server from
Multiple SysMan Clients
More than one SysMan client can connect to a single server at the same time.
The target machine’s connection display will then show the IP addresses of
multiple SysMan users that are connected:
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RC Server User Interface
Local Management
Notification Icon
If enabled in Windows, the SysMan Remote Control service will appear as an icon in
the Windows notification area on the target machine. When a remote control session
is active the icon is green and faces downwards. When there is no current Remote
Control session, the icon is purple and faces upwards. See the example below.
Server in listening mode: no connections are active

Server active: one or more remote clients are connected

Right-click the icon to display a full list of available menu options.
Note: availability and usage can be restricted by the administrator. As such, options
might be grayed out and unavailable
All options are discussed on the following pages.
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RC Server Notification Icon Menu Options
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o

Settings: Opens the Options window in which various settings can be
configured; for instance, session passwords, Windows authentication,
session confirmation and remote and local privileges. Please refer to the
Managing SysMan RC Server Service Settings section of this document for
a full list and description of these options.

o

Disconnect All Viewers: Terminates all active sessions on this node

o

Show Current Connections: If not already displayed, this option shows a list
of current connections to the local machine. This display is discussed in
more detail later in this document:

o

Close SysMan Remote Control: Terminates all running sessions (if any) and
closes the SysMan Remote Control Server service.

o

About SysMan Remote Control: Shows general information about the
installed SysMan RC Server.
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Connection Control
Accept / Reject a Session
If the “Confirm incoming connections” server option is set, then a logged in
user of the target machine will be prompted with a message to accept or
reject a connection request.
Depending on the default action set for connection requests, the “Accept
Connection?” window will either Auto-Accept or Auto-Reject the
connection if no answer has been given within the configured time-out
period:

The relevant server settings are circled in the dialog below:
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Confirmation That a Session has Begun
A pop-up message appears on the desktop to alert the logged-in user that their
session is now being observed by SysMan Remote Control.
Additionally, if the “Show connection list when active” server option has been
set, the Current Connections window will also appear and show the address(es)
of the connected client(s).
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Terminating Sessions
To terminate a single connection, select it in the Current Connections
window and press the Disconnect button. The selected connection will be
ended immediately.

To terminate all currently-established connections, invoke the Disconnect
All Viewers option from the SysMan Remote Control Server menu:
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Interaction with the Connected Client
Chat in Current Session
To open a chat session with the SysMan user from the local machine, select
the relevant connection in the Current Connections window and press the
Chat button:

A chat window such as the example below will appear, allowing interaction
between the users on each side of the connection:
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